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New in Capstan Welcome!

Welcome!

Many thanks for your interest in Capstan and a warm welcome to the circle of 
Capstan users!

Capstan is an all new method to correct wow and flutter problems. It detects 
pitch problems directly from the inside of the musical signal and corrects them as 
straightforward as possible: by speeding up and down the playback of your audio 
file directly reciprocal to the speed changes which generated the problems.

We at Celemony have worked hard to make Capstan as pleasant to use, as power-
ful, and as useful as possible. Let us know how you like it and what we could 
improve. And don’t hesitate to contact us if anything doesn’t work quite the way it 
should – at capstan@celemony.com we’re always there for you.

We hope your work with Capstan will be productive and that you’ll have fun with it 
at the same time!

Kindest regards,
all at Celemony

New in Capstan 1.2

Capstan 1.2 adds a new High Resolution mode, which increases the analysis 
resolution by a factor of 4. So far Capstan was able to correct flutter speeds up to 
10 Hz. Once activated in the preferences, the new HR mode allows for correction 
of flutter speeds up to 14 Hz and cares for even more precision in general.

The downside: it takes a lot(!) more time for the analysis and introduces more lag 
when working on large files. So be sure to run it on a modern computer with a fast 
CPU and lots of memory (at least 16GB).

Files are compatible back and forth. Older .capstan files will play on Capstan 1.2 
(in standard resolution), files analysed in Capstan 1.2 HR mode will play also 
on older Capstan versions (in high resolution). The HR mode is part of the initial 
analysis procedure and cannot be changed later.

You can check wether the .capstan file is generated in HR mode in the file inspec-
tor of Capstan 1.2.

New in Capstan 1.3

• Capstan is once again compatible with the newest iLok driver software
• Capstan 1.3 is now able to work on sound files larger than 1.5GB
• �HiDPI: On suitable systems running Windows 8 or later, Melodyne now supports 

the high resolution screen
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How Capstan worksInstallation and activation

How Capstan works

Capstan looks inside the music. It analyzes the polyphonic content and compares 
the individual notes. If a pitch movement is found only in one voice, it is taken as 
an intended musical expression by the performer. Such pitch movements should 
remain untouched. But if a pitch movement is identical or dominant in all notes, 
it must be coming from the recording medium and needs to be corrected.

The more complex the music is in terms of polyphony, the easier it is for Capstan 
to find all necessary corrections automatically. This makes Capstan’s fields of ap-
plication reach from classical Orchestral music to Pop or Rock recordings, mainly 
being used on complete mixes.

The less polyphonic the music is, the more manual help is needed. Further down 
you will find detailed suggestions on how to deal with such rather complicated 
material.

Detection first, repairing later – the governing principle
How does Capstan manage to find the speed deviations in your audio material? 
The answer (or the crux of it) is this: through its analysis of the material. As soon 
as audio is loaded into Capstan, it examines the entire file and seeks to detect the 
musical tones within it. It then decides which pitch movements are intentional vi-
brato effects by the performers and which pitch movements are caused by defects 
of the medium – be it a tape, record or wax cylinder. The resulting Speed Curve of 
your medium will be displayed blue in the lower pane. When the line goes up the 
original material speeds up, resulting in higher pitch, and when it goes down your 
material slows down, resulting in lower pitch.

Installation and activation

Installation and terminology
Capstan is very easy to install: just launch the installation program (either from 
the program CD or the download) and follow the onscreen instructions. The whole 
installation takes, at most, a few minutes. Before using the program, however,
you must register and activate Capstan. Here is a brief explanation of the termi-
nology:

Serial number: Your serial number represents your license for Capstan.

Registration: Registration involves the creation of a user account linked to your 
serial number. You set up such an account at www.celemony.com/mycelemony, 
where online instructions will guide you. If you purchased Capstan from our web 
shop, the registration is already complete.

Activation: Once registered, your Capstan license must be transferred to an iLok. 
This means, Capstan can only be used when you own an iLok dongle, which is 
sold separately in every pro audio music shop. 

Connect the iLok dongle to your computer and proceed like this:
1. �Go to your myCelemony account and use the option “Transferring your license 

to your iLok account”. At this stage you will be asked for your iLok account 
name. If you don’t have one yet, go to www.iLok.com and create an account.

2. �In your account at iLok.com navigate to “new licenses available”. There you 
will find the Capstan license waiting for you. Download it to your iLok dongle by 
following the onscreen instructions.

After this procedure you will be able to activate and operate Capstan on any 
number of different computers, but only on one at a time: that is to say, only on 
the computer in which the dongle is inserted.

Demo mode
When no iLok license is found, Capstan can be used in Demo mode. In this mode 
you can import files of any length. Playback is possible for only 7 seconds at a 
time, though, then playback will stop. Furthermore the saving of a .capstan file 
and file export is not possible.
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Apply Speed Curve to other files...
You can apply the correction of one file to any number of other files. Prerequisite 
is that those other files share the same attributes (sample rate, bit depth and file 
length) with your source file.

This feature comes in handy in a variety of situations:
• �Surround mixes: Perform your analysis and edits on the L/R channels and apply 

them to the Center and Surround channels.
• �Multitracks: Perform your analysis and edits on a temp mix of all channels and 

apply them afterwards to the individual channels. This way you can also control 
which channels you want to include in the analysis. You can exclude challenging 
channels like the vocal tracks to get a more robust wow&flutter detection.

• �Experimental: Try steep filters to filter out sound that disturbs Capstan’s 
analysis. Create a temporary file just for analysis and editing and then apply the 
Speed Curve to the original file.

The Speed Curve

The Speed Curve

This detection process takes place shortly after the file is loaded. The time 
required for this depends upon the processing power of the computer and upon 
the length and musical complexity of the file. If you want to stop the detection 
process, simply close the window.

The need for this analysis explains why Capstan cannot operate as a real-time 
effect like a Denoiser or Declicker: only when the analysis is complete, the Speed 
Curve can be displayed. The correction though does work in real time: every alter-
ation you make to the process in Capstan can be heard instantly – with no delay.

How the correction works
Once Capstan knows the Speed Curve of your audio material, it will vary the play-
back speed of your audio file. When your audio speeds up, it will slow down the 
playback, and vice versa. It’s a pure resampling process. There is no pitch shifting 
or time stretching involved which could harm your audio quality.

File formats
Capstan imports and exports all common mono and stereo audio file types in 
bit rates between 16 and 32 bit, both fixed and floating point. It can work on 
sampling rates up to 192 kHz. Split Stereo files will be opened automatically 
as stereo once you load the .L or .R file. During export Capstan will create Split 
Stereo files again.

Capstan stores its detection data and your edits in a .capstan file which will be 
saved next to your audio file. When opening a .capstan file, the program will 
always assume the corresponding audio file at the same location.
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Tutorial

The Export Dialog

Flutter
The next case is the flutter problem of “example 2 flutter.wav”. You notice that 
again Capstan does a splendid job finding the proper Speed Curve. But it still 
shows some disturbance. That’s because, in this specific example, Capstan 
simply doesn’t do enough of its correction. To rise the intensity of the process 
click on the thicker blue line in the middle of the upper waveform pane and drag 
it upwards. Additionally, a little smoothing of the Speed Curve helps. Select the 
Smoothing Curve – that’s the thinner blue line below – and drag it upwards little 
by little. Compare your editing with the “example 2 flutter.capstan” file from the 
Examples folder.

The Intensity Curve

The Smoothing Curve

Tutorial

In most cases Capstan will do its job almost automatically. To give you a smooth 
learning curve for the more complicated cases, we prepared short audio files 
which show common pitch defects. You find them in the “Examples” folder at this 
location:
Win: C:\Users\Public\Documents\Celemony\Capstan\Examples
Mac: Users/Shared/Documents/Celemony/Capstan/Examples

Additionally to the *.wav files we included our *.capstan files, so you can compare 
your edits with our preparations.  
Please use this tutorial in standard resolution mode (HR mode disabled in the 
preferences, as default).

Wow
Please load “example 1 wow.wav” by loading it through the Open dialog from the 
File menu. After the analysis took place you see the slow speed changes displayed 
in the lower pane. To hear the original file first, press “O” and hit the Space Bar. 
Now compare it to the processed version: hit the Space Bar to stop, press “P” and 
hit the Space Bar for playing back again. Now you listen to the corrected version, 
as it came out after the analysis (without any other editing actions taken by you). 

To toggle between original and processed version you can also switch between “O” 
and “P” while playback is running. 

In this audio example Capstan obviously has little problems to find the right 
Speed Curve; the problem is repaired instantly – all you needed to do was loading, 
waiting for the analysis to finish and playing back as “Processed”. 

Now that you are happy with the result you might want to export your restoration. 
Select Export from the File menu and export it to your desired destination. Alter-
natively use Ctrl-E on Windows or Cmd-E on Mac. 

Please note that you can select the desired output bit depth in the lower left 
corner of the Export dialog.
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As noted before in the section “How Capstan works” Capstan works best when 
the music is complex. In this example we have a static string background with 
a solo viola playing vibrato. This vibrato is so dominant that Capstan takes it for 
the Speed Curve. As there are hardly any defects outside this one big pitch drop, 
one can reduce Capstans intrusion through modifying the intensity and smoothing 
curves. Compare your settings with the “example 3 fall.capstan” file. There are 
several possible solutions.

Removing unwanted correction

Fixed pitch
By default, Capstan calculates the average pitch from your audio file and corrects 
your audio to this average as the reference or concert pitch. The resulting file has 
the same length as the original file. When things go really wild, you may want to 
define a specific reference tone yourself. Load “example 4 really wild.wav”. First 
thing you notice is the jump of the Speed Curve at 2.5 seconds which persists un-
til the end. Draw a range beginning at the jump. When you then shift- doubleclick 
on the right-hand side of the range, it will be extended until the end. Now move 
the Speed Curve one semitone down by hitting the Arrow-Down key.

Identifying the Intensity and Smoothing Curves

Speed drop
Capstan will always choose the nearest line next to the given reference tone. In 
“example 3 fall.wav” you can already see in the background structure, how far 
the speed drops shortly before second 8. The background shows the analyzed 
dominant pitch curve, with parallel lines semitones apart. As the pitch falls down 
at a certain point the Speed Curve jumps up to the next semitone, because it is 
closer to the reference tone (the straight red line). Draw a range between the jump 
up and the following jump down and drag the blue Speed Curve down. It will snap 
to the next and here correct semitone.

Before Speed Curve edit

After Speed Curve edit
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The elements
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The Main Window

1: Transport
You can operate Capstan just like a tape machine and play forwards as well as 
backwards in different speeds. There are several ways in Capstan to play sound:
• �Use the mouse and click the transport buttons.
• �Position the playhead cursor by clicking in the background of either the upper or 

lower pane or the timeline ruler. Then press the space bar to start playback.
• �Double-click in the timeline ruler to start playback right away from the clicked 

spot.
• �Use the standard Avidtm shortcuts “J”, “K” and “L” on your keyboard. “J” and 

“L” will play backwards and forwards. Hitting these keys several times in a row 
will increase the speed to 2x, 4x and 8x (fast forward or reverse playback). To 
pause, press “K”.

• �For slow-motion playback hit “N” or “M”. First press will play at ¼ playback 
rate, second press at ½ rate.

When you now play back the processed audio you notice a drop in the overall 
pitch. Open the Inspector (either from the File menu, the “I” button on top of the 
window or via the shortcut Ctrl-I) and select the Pitch & Duration register. There 
are several options to choose from. You see that “Set Pitch to Average” is selected 
and that Capstan calculated a reference pitch around 430 Hz which is surely too 
low. To correct this, select “Set Pitch to Fixed” and type in 443 Hz, that’s the 
reference “A” this recording was made with.

Set Pitch to Fixed
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7: Curve points
Both, Intensity and Smoothing Curves, can be automated. When you have drawn a 
range, simply drag the curve in the desired direction. There will be 4 curve points 
created automatically.

When you drag the curve while playing back, the playback will automatically start 
again.

Editing the Intensity Curve within a range

A double-click on the curve will create a curve point. A double-click on an already 
existing point will delete it. If the curve point is inside a range, all other points in 
this range will be removed along with the deleted one.

To reset the complete curve, double-click in the scale ruler on the left side of the 
waveform on the default curve positions (the mouse cursor will change its shape). 
For resetting the Intensity Curve double-click at value 1, for resetting the Smooth-
ing Curve double-click at value 0.

2: Original/processed
Use these buttons to toggle playback of your original audio or the processed au-
dio. Alternatively use the keys “O” for original and “P” for processed. Shift-O and 
Shift-P will play again from the position of the last playback start. When switched 
to original the Speed Curve will be grayed out.

3: Inspector
This button opens an additional window; please see chapter “Inspector”.

4: Intensity Curve
Increases or decreases the amount of correction. Default value is 1. A value of 0 
does not mean there is no processing at all, a value of 0 means that the Speed 
Curve equals the Drift Curve. (see chapter “The Pitch & Duration register”).

5: Smoothing Curve
Filters out faster changes of the Speed Curve. Default value is 0.

6: Range
To draw a range, click and drag in the background of either the upper waveform 
pane or the lower pitch pane. Holding the mouse over the edge of an existing 
range changes the mouse cursor to a range modifier. To extend the range to the 
end or the beginning, shift-double-click outside the existing range.

In the waveform pane a range can be drawn with finest resolution. In the lower 
pitch pane the range will always snap to places logical to the detection process.

Extending the range
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9: Pitch pane background
The background structure of the lower pitch pane illustrates the pitch develop-
ment. It helps you to identify spots where you would need to edit the Speed 
Curve. For example, if the pitch drops really hard, the Speed Curve will suddenly 
jump from one semitone to the next. 

10: Navigation
For navigating in your material there are several possibilities:
• �Call up the Hand Tool by Ctrl-clicking (Windows) or Cmd-clicking (Mac) in the 

background of any of the two panes and drag the mouse. Drag to the left and 
right to move inside your file, drag up and down to zoom in/out horizontally.

• �Move the scrollbar at the lower end of Capstans main window to the left or right 
to move inside your file. Alternatively you can use the two buttons (with the 
small arrows) on the right-hand side of the scrollbar to move left or right.

• Scroll back or forth in your timeline by hitting left arrow or the right arrow key. 
• �Click and drag the ends of the scrollbar to zoom in and out horizontally. Double-

clicking the scrollbar will zoom out completely.
• �Horizontal zooming can also be done with the shortcuts Ctrl-left/right-arrow 

(Win) or Cmd-left/right-arrow (Mac)

11: Pitch pane vertical zoom
In certain situations you may want to zoom in vertically, e.g. when adjusting 
drastic jumps in the Speed Curve. A vertical zoom is performed with the two but-
tons (with the waveform symbol) on the right-hand side of the scrollbar or with the 
shortcuts Ctrl-up/down-arrow (Win) or Cmd-up/down-arrow (Mac).

12: The timeline ruler
The time ruler displays the positions in your file in seconds. You can use the ruler 
for setting up a cycle, in order to play back a selected passage repeatedly (in a 
‘loop’).
Define the cycle range by clicking and dragging in the lower part of the Bar Ruler. 
Toggle Cycle Mode on and off by double-clicking on the cycle range. When inac-
tive, the cycle range is light grey.
Change the Cycle length by dragging the right- or left-hand borders of the cycle 
zone.
Move the Cycle range en bloc by dragging the middle of the cycle zone to the left 
or right. 
With all the above actions you will notice that the cycle borders snap to 1/10th 
seconds. To get a finer resolution hold the Alt-key while dragging.

Resetting the Intensity Curve by double-clicking the left ruler on „1“

It is also possible to reset only a part of the curve to the default values. For this 
approach you first draw a range and then double-click on the appropriate spot on 
the left ruler. The reset will then only be done only for the selected range. 

8: Speed Curve
This is the core of Capstan. After Capstan analyzed the musical content of your 
audio file, it will display this blue line. When the line goes up it means an ac-
celeration of both, pitch and tempo, had happened in your original material. When 
the curve goes down, this indicates a deceleration. To correct the speed problem 
of your audio source, Capstan plays back the audio file with the inverse Speed 
Curve. In other words: when your original material speeds up, Capstan speeds it 
back down and vice versa. That way you get a perfect correction of your recording.
For editing the Speed Curve refer to the next chapter.

8b: Target Reference Pitch 
The red line represents the target reference pitch to which Capstan corrects your 
audio. In the Inspector you find several choices how the reference is built. Please 
refer to the chapter “Inspector”.
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Editing the Speed Curve with the Pencil Tool

Please note that your intensity and smoothing values will be applied to your draw-
ing. Only in default intensity and default smoothing settings will the drawing be 
applied like you created it. You will notice a thin white line beneath the Speed 
Curve, though. This is the originally detected Speed Curve without any intensity or 
smoothing changes.

Resetting the Speed Curve to the original detection is possible by using the com-
mand “Reset Speed Curve to Detection” in the Edit menu. This resets the whole 
curve. If you draw a range the command reads “Reset Speed Curve to Detection in 
Selection” and resets only the part you selected.

Please note: This command does not reset the edits done with the Intensity and 
Smoothing Curve. Those edits can be reset individually (as described earlier).

Editing the Speed Curve
Editing the intensity or smoothing curves is actually changing the Speed Curve. 
This process can easily be heard and seen (the curve changes its shape). In addi-
tion to using the Intensity and Smoothing Curves you sometimes want to directly 
modify the Speed Curve itself. Therefore it is possible to move parts of the Speed 
Curve up or down. To do so, specify a range and move the curve either by dragging 
it with the mouse or by using the up/down arrow keys. The curve then will snap to 
the next semitone(s).

Moving a section of the Speed Curve up or down

For super-special cases one can also directly draw the Speed Curve with a Pencil 
Tool. Hovering the cursor over the Speed Curve changes its appearance into such 
a pencil. Now click, hold and drag the mouse to draw a new curve.
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The Pitch & Duration register
The Pitch & Duration register is a very important one. Here you define the tonal 
aim of your correction. 

The Pitch and Duration register

Drift Tracking 
The term Drift describes the slower average pitch variations in the music, which 
for example happen when the battery of a tape recorder is getting low or the pitch 
center of an a cappella choir slowly drifts over time. With the Drift Tracking slider 
you control the speed at which Capstan is following this drift.

When you pull down the Intensity Curve all the way to 0 you may still see the 
Speed Curve moving, depending on your material. This remaining movement is 
the drift. Now, push the Drift Tracking slider all the way to the right, to its slowest 
setting, and you’ll observe the speed curve becoming totally flat. Only now you will 
have a complete bypass of any pitch correction. The more you push the slider to 
the left, to a faster setting, the more pitch movement you correct while intensity 
equals 0. So, with the proper setting you can make sure that Drift correction is 
independent from your Wow&Flutter correction.

Inspector

The Inspector is a floating window with four registers providing you with detailed 
information and specific settings for your current file. Even if you have opened 
multiple files, you will only see one Inspector, which changes its content depend-
ing on the active window.

The File Info register
The File Info shows the location of both, your audio and capstan files, as well as 
the technical specifications of your audio file. The new “Analyzed in High Resolu-
tion” tick box (display-only) tells you wether the file is analyzed in HR mode or not 
(see also page 4 and 29).

Displaying the File Info
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and end point in the corresponding Range fields at the bottom of the panel. Then 
you choose “Set Duration in Range to” and define the duration of your destination 
by typing in the desired value. 

Range Start and End
Specify the range by typing in the desired positions. The displayed timecode 
standard displayed is set in the View register of the Inspector. Instead of typing in 
the values you can also transfer the actual time position of your playhead cursor 
by using the  drop down menus of the start and end fields.

But in most cases you will not touch this slider, the default middle position is fine 
for the majority of applications.

Pitch follows Drift 
Usually you want to correct the drift to a constant pitch (“Set Pitch to Average” 
or “Set Pitch to Fixed”). The option “Pitch Follows Drift” is for special cases. As 
an example, imagine an a cappella choir which is always floating a bit around the 
reference. With this option you can track the slow movement of the reference and 
correct to this target, thus keeping the natural drift alive.

Notice how the red line, the target pitch, follows the drift of your material. If this 
option is set, the red line represents the Drift Curve explained above.

Set Pitch to Average (default)
By default Capstan will analyze the pitch of your whole audio file and calculate its 
average reference pitch. This pitch will then be used as the target reference to fix 
your music. The result of “Set Pitch to Average” will be a file with the exact same 
length as your original.

Notice that the red line is straight. Drift will be corrected to a constant target 
pitch.

Keep Original Duration in Range
“Pitch follows Drift” can be combined with the option “Keep Original Duration in 
Range”: then the drift curve as a whole will be multiplied with a factor to keep the 
duration identical.

As “Set Pitch to Average” will always give an identical duration, this option will be 
checked automatically..

Set Pitch to Fixed
Often you want to define a fixed pitch, especially when you know exactly which 
reference the performers were tuning their instruments to. In such a case choose 
“Set Pitch to Fixed” and enter the desired reference pitch. You then get a perfect 
correction of all pitch problems, including shrinkage of the complete tape.

Set Duration in Range to 
When you need your audio to be synchronized to a picture, the option to set a 
duration comes in handy. You would then specify the “Range” by typing in start 

One note about pitch detection: 
Capstan always goes for the semitone closest to the 440 Hz standard, it 
doesn’t know the absolute reference pitch of your material. Thus, if your mate-
rial is off more than a quarter tone, Capstan will snap to the nearest semitone, 
take that as the “A” and tell you a wrong average pitch.

Let’s look at an example. Music played on historic instruments is often tuned 
to 415 Hz. This sounds roughly a semitone lower than when played on modern 
instruments: the historic “A” sounds like a “G#” to modern ears. Capstan 
doesn’t know which note is the A, it takes the note closest to 440 Hz, takes 
that as the “A” and reports its frequency. So in this historic music example 
Capstan will take the “A#” as the reference and reports “A = 440 Hz”, which 
is wrong. As soon as you edit the Speed Curve and move it to the real “A”, 
Capstan will correctly report “A = 415 Hz”.

Since you likely want to keep the historic tuning in this particular example 
you set the correction method to “Set Pitch to Fixed” and type in 415 Hz. Of 
course, since the correction factor is the same here in this particular example 
(factor 1), you get the same sonic result as if you had left the analysis at 440 
Hz and corrected it to 440 Hz.

But in the real world you will often encounter recordings which are so far off 
in pitch that you actually have to correct more than a quarter tone. So please 
check the key and make sure Capstan has the correct “A”. Otherwise you 
might get Chipmunks fun!
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View

The View register

Original and Processed Time 
Original Time shows the actual timecode position in your original audio. 
Processed Time shows you the actual timecode position in your processed audio.

Contrast and Brightness
The Contrast and Brightness sliders help you to change the visibility of the lower 
pitch pane background structure.
Timedisplay 
Timedisplay changes the timecode standard.

Active Curve 
Active Curve helps you to identify and select the curves in the upper waveform 
pane, especially when those curves cross each other.

Show Doubted Ranges 
Show Doubted Ranges will display sections in your Speed Curve where Capstan 
spotted ambiguous pitches. It can help you with identifying problems in harder 
cases. Doubted Ranges can also be shown via the shortcut “R”.
To go from one Doubted Range to the next use the left/right arrow keys.

Marker

The Marker register

For adding comments and reminders to certain spots in your audio file you can set 
markers. In the Marker register of the Inspector you can set a marker by clicking 
the “+” button.

To call up a marker, simply click it (while playback is stopped). The playhead posi-
tion will then jump to the corresponding position.

Name or rename a marker by double-clicking its name and delete the marker by 
clicking the “-” button.

To change the position of a marker double-click on it in the Position column and 
type in a new value.
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Preferences

Preferences

The Preferences window offers several tabs, each with a number of options gov-
erning the behavior of Capstan. All settings done here will be the same for each 
document and for every program start. When you change any of the Preferences 
settings, these changes will remain permanent for all upcoming program starts – 
unless, of course, you change them again.

Open the Preferences window in the Help menu (Windows) or the Capstan menu 
(Mac). 

Configuration tab

The Configuration Tab in the Preferences window

High Resolution Analysis 
This option increases the initial analysis resolution by a factor of 4 compared to 
standard resolution. It works during opening and analysis of your audio file and 
cannot be changed later. HR mode allows for correction of flutter speeds up to 14 
Hz (compared to 10 Hz in standard resolution) and cares for even more precision 
in general.

Make sure to use it only on a modern computer with a fast CPU and lots of mem-
ory (at least 16GB), as it it takes a lot(!) more time for the analysis and introduces 
more lag when working on large files.
 

Auto Scroll
Auto Scrolling will make the waveform and Speed Curve display follow the play-
head cursor. It can be activated and deactivated with the shortcut “A”.
Please note: Auto Scrolling will be turned off temporarily as long as you have 
selected a range for editing.
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Audio tab
Here you choose the audio driver and specify its settings. 

Setting up the audio driver in Preferences>Audio

Shortcuts tab
Here you define shortcuts. Each function has a pre-set shortcut. To change this 
default, click on the function and, while it is highlighted, type in the new shortcut 
you want to specify. You may use any single key or a combination of it with one or 
more modifier keys (Shift, Alt, Ctrl or Cmd). 

Defining Shortcuts in Preferences>Shortcuts

Auto Save after Detection 
When this option is checked, Capstan will save a *.capstan file containing the 
result of the analysis, that took place upon loading the raw audio file. You can 
open multiple files at once to run the detection as an unattended batch process. 
The results will be automatically saved. 

Start Playback ... 
Here you choose, which behavior you prefer when starting playback via the Space 
Bar after Capstan was stopped: should the next playback continue from where you 
just stopped or should it play back from the same position as it did the last time?
Please note: The behavior, you did not choose here, will automatically be triggered 
by Alt-Space (or whatever key you defined for this in the Shortcuts tab).

Selection Preroll Time
When a range is selected in the main window, the next playback will start at the 
beginning of this range. You can, however, define a Preroll time, to let the play-
back start a few seconds before the beginning of that range.

Continuous Edit Update …
When editing the Speed Curve your changes are reflected immediately, since the 
blue curve gets redrawn permanently while you work on it or on the Intensity or 
Smoothing Curves. This redrawing takes some processing power and, depending 
on the length of your audio file and depending on the power of your computer, the 
permanent update of the curve may feel sluggish. For such cases you can define 
a maximum file length, forcing Capstan to only do permanent redrawing on files 
that are shorter than this maximum. When your file is longer, you will notice that – 
while dragging any of the curves – the blue Speed Curve doesn’t change and it is 
gray until you release the mouse. This is, however, only an optical issue; the audio 
result will always be real-time.

Fast Playback Dim
When playing back fast, using the Shortcuts “J” and “L”, the playback level will 
be dimmed by an amount, that you can set here.
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Preferences

Version tab

Looking for updates in Preferences>Version

This Version
A display of your current version. In case you need assistance from our support 
team, they may ask you for the information displayed here.

Check for Updates
When your computer is connected to the internet, you can check, whether your 
Capstan version is up-to-date. You may set an interval (daily, weekly, etc.) for 
Capstan doing an automatic check. Or you use “Check Now” to find out right away 
if a new version is ready for download. If there is a new version available, you will 
be guided onscreen through the downloading process.

Last Check, Status, Next Check
Here you can see when the last update check did happen and when the next 
check will be performed.
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